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Preface 

The Environmental Management Program (EMP) was established by Con- 
gress to protect and manage biotic resources of the Upper Mississippi River 
System (UMRS).  As part of EMP, Habitat Rehabilitation and Enhancement 
Projects (HREP) were planned for specific areas in the UMRS. These proj- 
ects will be constructed in large rivers of the UMRS and include removal of 
sediments from backwaters, placement of water control structures to manage 
water levels in backwater areas, and restoring flows to side channels. 
Approximately 100 HREP projects are planned for the UMRS, each project 
taking 1 to 2 years to complete.  A habitat evaluation of each project is 
required to document environmental benefits and assess alternative project 
design features.  Consequently, an Aquatic Habitat Appraisal Guide (AHAG) 
was developed as a planning tool to meet the habitat evaluation requirements 
of each project.  This document explains the development and use of AHAG 
to evaluate HREP in the UMRS. 

Authors of this report were Mr. Dean Mathias, Blue-Six Software, Inc., 
and Dr. Thomas B. Hardy, Utah State University, Dr. K. Jack Killgore, 
U.S. Army Engineer Waterways Experiment Station (WES), and 
Mr. Joseph W. Jordan, U.S. Army Materiel Command Installation and 
Services Activity, Rock Island, IL.  Messrs. Bob Clevenstine and Jon 
Duyvejonck, formerly with the U.S. Army Engineer District, Rock Island, 
assisted in the conceptual design of AHAG. Dr. Jan Jeffrey Hoover and 
Mr. Jim Morrow, WES, and Mr. David Gates, U.S. Army Engineer District, 
St. Louis, provided technical assistance.  AHAG was reviewed by fisheries 
biologists from the U.S. Fish and Wildlife Service, Iowa Department of Natu- 
ral Resources, Wisconsin Department of Natural Resources, Missouri Depart- 
ment of Conservation, Illinois Department of Natural Resources, and Illinois 
Natural History Survey.  Special thanks to Mr. Matthew D. Chan, WES, for 
his editorial assistance. 

During the conduct of this study, Dr. John Harrison was Director, Envi- 
ronmental Laboratory, Dr. Conrad J. Kirby was Chief, Ecological Research 
Division, and Dr. Edwin A. Theriot was Chief, Aquatic Ecology Branch, 
WES. 

At the time of publication of this report, Director of WES was 
Dr. Robert W. Whalin. Commander was COL Bruce K. Howard, EN. 
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Conversion Factors, Non-SI to 
SI Units of Measurement 

Non-SI units of measurement used in this report can be converted to SI 
units as follows: 

Multiply By To Obtain 

acres 0.4047 hectares 

feet 0.3048 meters 

miles (U.S. statute) 1.609347 kilometers 

pounds (mass) 0.4535924 kilograms 

VIII 



1     Introduction 

An Aquatic Habitat Appraisal Guide (AHAG) was developed to evaluate 
fish habitat in the Upper Mississippi River System.  AHAG is based on the 
concept of the Habitat Evaluation Procedure (U.S. Fish and Wildlife Service 
(USFWS) 1980) and follows the format of the Wildlife Appraisal Guides 
(Baske« et al. 1980). AHAG is used to numerically rate habitat quality for 
individual species of fish under varying environmental conditions and to docu- 
ment benefits of environmental features (e.g., creation of slack-water habitat 
and construction of weirs) incorporated in the project design. 

This user's manual provides an overview of AHAG and instructions on 
using AHAG software.  The software integrates Habitat Suitability Index 
(HSI) scores to calculate Habitat Units (HUs) for each evaluation fish species. 
Life stage (spawning, rearing, and juvenile/adult), habitat (lentic or lotic), and 
season can be included in the assessment. The software compares HUs among 
different project alternatives and places this information into tables or output 
files. 

A default matrix of HSI values for eight evaluation species can be used to 
calculate HUs or new values can be created. Development of the default 
matrix is shown in Chapter 10 and includes selection of evaluation fish species 
and description of habitat variables used in AHAG.  Modification of habitat- 
based models is encouraged to be more applicable for a particular geographi- 
cal area where different habitat factors may be limiting (Layher and Maughan 
1985; Hubert and Rahel 1989).  AHAG software makes modification easy, 
while providing a permanent record of the assessment process. 

Overview of AHAG 

AHAG is a general planning tool used to rate habitat quality for fish spe- 
cies using the following generalized equation (USFWS 1980): 

HU = HSI * AREA 
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where 

HU = Habitat units 

HSI = Habitat Suitability Index that ranges from 0.0 to 1.0 

AREA = Area of project site such as acres 

Format of AHAG is shown in Chapter 10. 

AHAG requires the user to input values of each habitat variable estimated 
from existing information or measured in the field depending on time and 
resources available. Predicting future changes in habitat can be accomplished 
through consensus or application of physical models (e.g., water quality and 
sedimentation).  Although AHAG does not require fish sampling as part of the 
evaluation, efforts should be made to verify relationships between habitat 
quality and fish abundance. Only through critical review of AHAG compo- 
nents combined with monitoring studies will the validity of an AHAG output 
be determined. 

Habitat Suitability Index Values 

Any variable can be used in AHAG. The default matrix (Chapter 10) uses 
five types of variables to evaluate fish habitat: physicochemical, habitat struc- 
ture, morphometric, hydraulic, and interspersion. When selecting variables, 
consider the following criteria:  Each variable may limit the abundance and 
distribution of the evaluation species, is directly affected by the engineering 
objectives of the project, is readily measured in the field, and can be predicted 
for future environmental conditions. 

AHAG uses a specific format to display HSI values (see Chapter 10). For 
each variable, the range of habitat values are divided into classes, and an HSI 
value is assigned to each class by life history stage (spawning, rearing, and 
juvenile/adults) of evaluation species. Each class interval is rated as excellent 
(1), good (0.75), fair (0.5), poor (0.25), or unusable (0) habitat. The AHAG 
software provides an option of using a continuous relationship (i.e., curve) to 
determine the HSI value by fitting a curve to the midpoints of each class 
interval (see Chapter 6 - AHAG Edit Menu). 

Normally, a final HSI value is multiplied by a measurement of area (e.g., 
acres) to obtain HUs. Final HSI scores are obtained using one of the follow- 
ing methods: 
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• Arithmetic mean of all variable scores (compensatory relationships). 

• Arithmetic mean of selected variables that are considered limiting. 

• Taking the single lowest HSI score (limiting factor). 

Compensatory relationships exist when a variable with marginal or low 
value is offset (or compensated for) by the high suitability of other variables 
(USFWS 1980). A limiting factor is used when the variable with the lowest 
suitability is perceived to be so significant that it overrides all other factors in 
the functional relationship (USFWS 1980). 

Season and Life History Stage 

Since habitat use varies by season, AHAG uses a wide range of values for 
each variable to permit an evaluation of the study area for winter, spring, 
summer, and fall conditions. Habitat conditions can become limiting to a 
species during a particular season, such as low water temperature and low 
dissolved oxygen in the winter.  Therefore, HSI scores should be calculated 
seasonally, and periods when habitat variables become limiting should be 
emphasized. 

AHAG provides a habitat quality rating for spawning, rearing, and adult 
life stages of the evaluation species.  Spawning is defined as deposition of 
fertilized eggs at a specific location and incubation of the eggs. Rearing is the 
phase of development from the moment of hatching, through yolk-sac larvae, 
absorption of the yolk, and ending when a minimum adult complement of rays 
is present in all fins and the median fin fold is completely absorbed (Wallus 
et al. 1990).  Juvenile/adult stage is when growth attainment is at or near 
maximum size, an adult complement of rays is present in all fins, and the 
median fin fold is completely absorbed through attainment of sexual maturity 
(Wallus, Yeager, and Simon 1990). 

For some species or life stage, there are no HSI values for a particular 
variable. This indicates that this species or life stage does not require this 
habitat variable for survival and growth.  In other cases, there are no low HSI 
values (i.e., 0 for unusable habitat; 0.25 for poor habitat), indicating that this 
variable may enhance growth, but is not a necessary requirement for survival 
of the species or life stage. 

Interpreting Model Outputs 

Habitat-based assessment techniques make specific assumptions on species- 
habitat relationships (Terrell 1984; O'Neil 1985).  Each assumption may be 
intuitively correct, but can only be verified from field studies.  Typical 
assumptions are as follows: 
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• Abundance and distribution of species respond in a predictable and 
measurable fashion to changes in habitat quality defined by the vari- 
ables in the model. 

• At least one of the habitat variables can potentially influence distribu- 
tion and abundance of evaluation species. 

• Habitat variables represent physical and water quality characteristics of 
the study area. 

Because of limited information on the life history of many species, the 
influence of competition and predation on habitat preferences, and variation in 
temporal distribution patterns of fishes, output of AHAG may not represent a 
causal relationship.  Thus, HUs may not be necessarily associated with popu- 
lation density. The proper interpretation is by comparison (USFWS 1980); 
areas with higher HUs should have the potential to support more fish than 
areas with lower HUs. 
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2    Overview of Software 

This chapter summarizes AHAG software including a description of each 
chapter. 

Chapter Content 

Chapter 3 Provides information on how to install AHAG and customize 
the system defaults. Describes the various system level 
settings and how they can be changed. 

Chapter 4 Provides information on how to initiate AHAG and sum- 
marizes its features. 

Chapter 5 Provides a detailed description on file operations within 
AHAG. 

Chapter 6 Describes procedures to edit various data sets when creating 
a study. 

Chapter 7 Discusses how to view calculations and how they are 
generated. 

Chapter 8 Provides instructions on using different kinds of help within 
AHAG. 

Chapter 9 Describes development and rationale of AHAG default 
matrices. 

AHAG includes the following features to aid in the assessment of aquatic 
habitats: 

• Three predefined default matrices for use in evaluation of aquatic 
habitats. These matrices include the following species: white bass, 
emerald shiner, river darter, northern pike, smallmouth buffalo, wall- 
eye, largemouth bass, and bluegill. For each of these species, three 
life stages are evaluated in the matrices. 

• The ability to define customized sets of species and habitat variables. 
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• 

Easy input and customization of the data contained within the HSI 
matrix. 

Easy and rapid access to output based on the matrices and time period 
data. 

Hardware and Software Requirements 

AHAG runs on the IBM PC compatible family of computers, including the 
AT and PS/2, along with all true IBM 8086, 80286, 80386, 80486, and Pen- 
tium computers.  It requires DOS 2.1 or higher, a hard disk, a floppy drive, 
and at least 600,000 bytes of conventional memory available; it runs on any 
80-column monochrome or color monitor. 

Here is an itemized list of components necessary to use AHAG: 

Computer IBM, or fully compatible, 8086 or better 

System Memory 600,000 bytes of available conventional RAM 

Hard Drive At least 2 million bytes available 

Monitor 80-column monochrome or color 

Graphics None required, but can use CGA or better graphics 

Floppy Drive One 360K 5lA or one 720K VA (required for installation) 

DOS MS-DOS 2.1 or higher 

Printer Epson or HP Laserjet compatible (not essential) 

Mouse Microsoft compatible mouse (not essential) 

AHAG Implementation 

AHAG was written completely in C language. It was coded such that 
future modifications can be easily incorporated into the package. Addition- 
ally, the software was written to be "User Friendly" in a way that is natural 
to the user.  This means that items, such as data entry, are implemented in a 
familiar context such as a spreadsheet type display.  The use of menus, func- 
tion keys, arrow keys, and mouse were also incorporated to aid in the ease of 
user familiarity of software. 
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AHAG Package 

The AHAG package consists of a single disk (upon request) and this 
manual as the user documentation. (See Appendix A for software order 
form.) 

Typefaces Used in These Documents 

All typefaces used in this manual were produced by WordPerfect for Win- 
dows on an HP laserjet printer. 

Monospace Type 

BOLD ITALIC 

This typeface represents text as it appears on the screen 
or in the program.  It is also used for anything you must 
type literally (such as AHAG to start up the program). 

This typeface is used to indicate menu choices that can 
be selected by using arrow keys followed by a carriage 
return. 

ALL CAPS 

Italics 

<KEY> 

This is used for names of files. 

Italics indicate variable input that appears in the docu- 
ment.  They can represent terms that you normally use, 
or any substitution (usually, your choice).  They are also 
used to emphasize certain words, such as new terms. 

This typeface is used to identify a key on the keyboard. 
For example, "Press <ESC> to exit a menu." This 
example indicates that you must press the Escape key in 
order to exit a menu. 
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3    Installing AHAG 

AHAG comes with an automatic installation program called INSTALL. 
You must use this program; you cannot just copy the AHAG files onto your 
hard disk. Instead, INSTALL automatically copies and creates additional files 
for use by the AHAG software. 

It is assumed that you are already familiar with basic DOS commands. 
For example, you'll need to use the DISKCOPY command to make backup 
copies of your distribution disks. Make a complete working copy of your 
distribution disks when you receive them; then store the original disks in a 
safe place. 

This chapter contains the following information: 

• Installing AHAG on your system. 

• Information about customizing the default setup of AHAG. 

• A pointer to more information on AHAG default matrices. 

Using INSTALL 

INSTALL will create the directories that are needed when installing the 
AHAG software. It also creates the system defaults file (based on your inputs 
during installation) and copies all files from the distribution disk to the appro- 
priate directories on your hard disk. 

To install AHAG: 

a.   Insert the AHAG distribution disk into your floppy drive (We will 
assume drive A). Type the following commands, with each followed 
by < ENTER >. 
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A:\INSTALL 

b.   Follow the installation program prompts to set system defaults 
(described below). 

The System Defaults menu describes the operating environment for the 
AHAG software. They are accessed by selecting the System Defaults menu 
choice from within the Options menu. When this choice is selected, a 
window titled System Defaults appears in the center of the screen.  System 
Defaults are edited within this window.  See Figure 9 for an example of this 
screen. 

Program Path 
Report Path 
Data Path 
Monitor 
Graphics 
Printer Port 
Printer Type 

SYSTEM DEFAULTS 

c:\models\ahag\progs 
c:\models\ahag\reports 
c:\models\ahag\data 
COLOR 
VGA 
LPT1 
EPSON 

Figure 1.     Example of System Defaults screen 

These defaults are initially set when installing the program for the first 
time.  However, they can be easily changed.  For example, for the monitor 
type, use the arrow keys to move the highlight bar to the Monitor selection, 
and use the < SPACE > or < ENTER> keys to switch between the choices. 
The next section explains each individual default option. 

System Defaults 

• Program path. 

The pathname (drive and directory) to where the AHAG software will 
reside must be specified.  This is used mainly for the installation pro- 
gram.  If this directory does not exist, the installation program will 
create it for you. This option should not have to change once the 
software is initially installed unless future additions of AHAG are used. 

• Report path. 
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The Report Path (drive and directory) is the location that AHAG will 
use to save any output requested by the user.  A variety of different 
report directories can be used, but remember that AHAG will send 
reports to the currently defined report pathname only. AHAG created 
the report directory C:\AHAG\REPORTS. Additional directories must 
be created by the user (refer to the DOS manual for more information 
on creating directories). 

• Data path. 

The Data Path is the pathname location where AHAG software will 
search for and save study files.  Study files can be stored in any direc- 
tory, but it is the users responsibility to create directories other than 
C:\AHAG\DATA and maintain the directory listing within the AHAG 
system defaults. 

• Monitor. 

This Monitor option specifies the type of monitor used with the com- 
puter that AHAG software is installed upon.  COLOR indicates a color 
monitor (i.e., CGA, EGA, VGA, etc.). MONO indicates a mono- 
chrome monitor (i.e., amber). 

• Graphics. 

The AHAG software will allow the user to graphically view some of 
the input data used by the models.  This option lets the user specify the 
type of graphics adapter to use when displaying the graphics. The 
available choices are CGA, EGA or VGA. 

• Printer port. 

The AHAG software can send reports directly to the printer.  In order 
to make this work correctly, the proper port where the printer is con- 
nected must be selected.  There are three possible choices for the 
printer port—LPT1, LPT2, or LPT3. Choose the correct printer port 
on your computer (most commonly LPT1) for the printing to work 
correctly. 

• Type of printer. 

The AHAG software has the ability to send printer data to two differ- 
ent types of printers. This option lets the user specify the type of 
printer he intends to use with the software. These two types are Epson 
or HP Laserjet compatible printers. 

To change system defaults after the initial installation to the hard disk, 
select the System Defaults menu choice under the Options menu and the 
system defaults editor will appear. When finished making changes, press the 
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<F10> function key to save these options. The changes to the system 
defaults become active upon returning from this editor. 

11 
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4    Using AHAG 

Running AHAG 

To execute AHAG, simply type AHAG (in the AHAG directory), followed 
by a carriage return at the DOS prompt.  The following is an example of this: 

C:\AHAG >ahag < ENTER> 

When AHAG is started, the program will display a small window on the 
center of the screen stating that the program is initializing itself. This will be 
followed by the main screen that contains the main menu bar across the top of 
the display.  The five menu choices are File, Edit, Calcs, Options, and Help 
(Figure 2). 

File     Edit     Calcs    Options  Help 

File: <NONE>       Status: 
Fl Help  F2 Save F3 Open 

Figure 2.     Example of AHAG main screen 

The main menu provides access to all program functions. The File menu 
contains all functions related to file manipulation, printing, DOS shell, and 
exiting the program. The Edit menu allows access into the different types of 
data that can be input into the program.  The Calcs option tells the program to 
display the results of the Field Data calculated using the model loaded into 
memory.  The Options menu provides access to the system level features of 
the software such as the program paths and system colors. Finally, the Help 
menu option allows access to the available on-line help. 

The function key line indicates which keys are currently available to the 
user.  The line just above the function key line is the status line.  The status 
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line shows the name of the currently loaded study file (and also what addi- 
tional cursor keys are available for selection by the mouse).  Each of the main 
menu choices are discussed in the next chapters. 

Keys Used in AHAG 

The following is a list of the most commonly used keys within the AHAG 
system relating to functions, cursor movement, help, and menu selection. 

<F1> 

<F2> 

<F3> 

<F4> 

<F5> 

<F10> 

<ENTER> 

<ESC> 

< Arrows > 

This function key is always used to invoke the context 
sensitive help screen at any point in the system. 

This function key is used throughout most areas in the 
system to save the current study file. It is used in the 
directory functions to view the header of the current file 
identified by the highlighted cursor. 

This function key is used to open the directory of data 
files to be loaded into memory. 

This function key is used while editing in the work sheet 
to open a pop-up menu to change the type of a cell. It is 
used in the calculations section to save results of calcula- 
tions to a file. It is also used in editing system colors to 
select foreground color. 

This function key is used while editing system colors. It 
is used to select background color for modification. It is 
also used to copy a field data sheet value across all target 
years. 

This function key is used to save System Defaults. 

This is the Enter or Carriage Return key on most key- 
boards. It is used to confirm selections from menus and 
to perform a variety of other selected tasks. 

This key is used to exit any current screen or menu 
option. 

These keys are used to move around in the work space 
and menus. 

<PGUP> 

<PGDN> 

This is used in various sections of the program to move 
the cursor up an entire page of data. 

This is the same as the < PGUP > key, except it moves 
the cursor down an entire page of data. 

Chapter 4   Using AHAG 
13 



< HOME >       This key is used to move the cursor to the beginning of a 
column of data. 

<END> This key is the complement to the <HOME> key.  It 
moves the cursor to the end of a column of data. 

< TAB > This key is used in the Calculations to move forward 
through the species and life stages and in other parts of 
the program to switch between two input items. 

< Shft-TAB >    This key combination is used in the Calculations to move 
backward through the species and life stages. 

< INSERT >     This key is used in various parts of the program to make a 
new space for input at the cursor location. 

< DELETE >    This key is used in various parts of the program to delete 
the currently highlighted selection. 

Using Pop-Up Menus 

Pop-up menus are windows that display a series of choices for selection. 
The menu will contain two or more options for selection.  When first encoun- 
tered, the first option of the menu will be highlighted.  This highlight bar can 
be moved by using the up and down or left and right arrow keys.  To make a 
selection from the menu, move the highlight bar to the desired option and 
press the < ENTER> key. 

Using Mouse 

The AHAG system supports the use of the mouse for most program opera- 
tions. In all areas of the program where the arrow keys can be used for 
cursor movement, there are also horizontal or vertical bars that are used by 
the mouse to control the cursor movement.  Below is an example of the Hori- 
zontal and Vertical scroll bars for use with the mouse. 

14 
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I:: Vertical Bars 

T 

•«::::::::::::::: ►    Horizontal Bars 

Scrolling in either the horizontal or vertical direction is accomplished by 
moving the mouse pointer to one of the arrow designations and clicking the 
primary (usually left) mouse button. Additionally, the mouse can be used to 
select the function keys on the function key line and other movement keys on 
the status line.  This is done by moving the cursor over the desired key and 
pressing the primary (left for right-handed users, right for left-handed users) 
mouse button. While editing an AHAG work sheet, the mouse may be used 
to position the highlighted cursor and further select that position for detailed 
editing. In general, the mouse is used much in the same manner as other 
software that supports use of the mouse. 

Editing Text and Data 

One basic function of the AHAG software is the ability to input text or 
data in various sections of the program. In all sections of the program where 
there are multiple entry fields (Definitions, Work Sheet, and Field Data), the 
cursor keys can be used to move about the different fields.  Once the cursor is 
located on the desired field to edit, there are two basic ways editing can 
begin. The first is to begin typing in the new information. When this is 
done, the previous information is erased and only the new data is accepted for 
input. The second approach is to first press the < ENTER> key to keep the 
current information, and only modify it in some way. During editing of the 
field, the <ESC> key can be pressed to undo any changes already made and 
have the previous information returned.  However, if the current editing is 
finished, press the < ENTER > key to signal the software to accept the entry 
and remove the previous data. 

Chapter 4   Using AHAG 
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5    AHAG File Menu 

The study file provides all necessary information on the project used in 
AHAG software.  All AHAG study models are stored using a single file for- 
mat.  This section provides information needed to create a new study, use the 
default matrices, and load other existing AHAG study files. 

The AHAG File menu is the first choice on the left-hand side of the main 
menu bar. From this menu, all of the file operations can be selected, hence 
the name File. Additionally, options for Printing and leaving the program are 
also contained within this menu.  The first five operations deal with creation, 
loading, saving, and deleting studies.  The next File menu choice allows 
access to printing functions, and finally the menu to leave AHAG software. 
Each of the options are discussed in more detail in the remainder of this 
chapter. 

Creating a New Study 

All study models are contained within a single file. When creating a new 
study, the AHAG software creates a new file in the data directory currently 
defined in the System Defaults (See Chapter 3 for more information about this 
feature). 

To create a new AHAG study, select the New menu choice within the File 
menu located on the main menu bar. When this choice is made, the program 
will ask for a filename with the following prompt: 

Enter the filename for this study... 
Filename: 

Simply type in the desired filename and press < ENTER > .  This will 
cause AHAG to create an empty study template that can be used to fully 
develop a new study. However, note that this study will not be saved until 
the users saves it (described below).  This template contains the following 
study parameters: 
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1 Habitat Variable 
1 Species 
1 Life Stage 
1 Histogram 
1 Target Year 

All of the data fields will either be zeroed, contain blanks, or contain the 
word < EMPTY >.  For more information about how to update and edit this 
template into an AHAG model, refer to Chapter 6—AHAG Edit Menu. 

Using Default Matrices 

The AHAG software package includes three default matrices that can be 
used in their current form or customized to meet a specific need. Chapter 10 
describes development of the default matrices. The names of these three files 
are DEFLT1.DAT, DEFLT2.DAT, and DEFLT3.DAT. These three files 
contain the same Habitat Variables, but represent a series of eight different 
species for evaluation. 

• DEFLT1.DAT 
White Bass 
Emerald Shiner 
River Darter 

• DEFLT2.DAT 
Northern Pike 
Smallmouth Buffalo 
Walleye 

• DEFLT3.DAT 
Largemouth Bass 
Bluegill 

Follow the directions in the next section on Loading a Study to use any one 
of these default matrices.  NOTE: If the data is changed in any one of these 
matrices, save that particular study using a different filename other than the 
default study filename. 

Loading a Study 

Once a study has been created, edited, and saved, it can then be loaded at 
a later time for further editing or used to generate calculations. To load an 
existing study file into memory, select the Open menu choice within the File 
menu or press the <F3> function key. When Open is selected, the program 
will present a window with the names of the files that are located in the data 
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directory as defined in the System Defaults (See Chapter 3 for more informa- 
tion).  Figure 3 shows an example of what this screen looks like. 

Name:   NEW.DAT 

Open a File 

DEFLT1.DAT 
DEFLT2.DAT 
DEFLT3.DAT 
PROJOLD.DAT 
PROJNEW.DAT 

i:       {Cancel] 

V [ok] 

Figure 3.     Example of Open a File window 

The Open a File window appears in the center of the main AHAG screen 
when first opened.  The main body of this window contains three columns 
where the filenames in the data directory will appear. The filename currently 
highlighted in a specific column will also be the filename listed by the heading 
of Name:.  The cursor keys can be used to move the highlighted cursor bar 
within this window to select the appropriate file for loading.  When the cor- 
rect file is highlighted, press either the < ENTER> key or use the mouse to 
select the [OK] button on the right-hand side of the window; that file will then 
be loaded into the program memory.  Additionally, it is also possible to type 
in the name of the file followed by pressing < ENTER > to load a file into 
memory.   Once the file is loaded into memory, the Open a File window will 
disappear and the filename of the study will now appear on the status line. 

Saving a Study 

There are two methods for saving a study currently loaded in the pro- 
gram's memory.  The first is to select the Save (or the <F2> function key) 
menu choice in the File menu or to select the Save As... menu choice in the 
File menu. When selecting the Save option, the computer responds by saving 
the study loaded in memory under the filename being displayed in the status 
line.  However, it is possible to save the study file under a different name 
than shown in the status line.  This is accomplished by selecting the Save 
As... menu choice. When this option is selected, a window exactly like the 
Open a File window will appear except it will be titled Save a File. From this 
window, you may type in the new name to save the study file under, or select 
an existing name from this list of filenames displayed in the columns below. 
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If the software detects that a file already exists with the same name, it will 
prompt the user to confirm whether or not to replace the currently existing 
file.  NOTE: When saving a file in this manner, the name of the file in the 
status line will be updated to reflect the change in the filename. 

Deleting a Study 

The final file manipulation option available from AHAG software is the 
ability to delete existing study files. This process is started by selecting the 
Delete menu choice from within the File menu.  Once selected, a window 
much like the Open a File window appears except it is titled Delete Files. 
From this point, files can be selected for deletion.  Simply move the cursor to 
the file to remove and press either the < ENTER > key, or use the mouse to 
select the [OK] button. The program will prompt with a message for confirm- 
ation prior to deleting the file.  Select [OK] to confirm the deletion, or select 
[CANCEL] to abort the delete operation.  When finished with deleting the 
various files, press either <ESC>, or select the [CANCEL] button to return 
to the File menu. 

Printing and Saving Reports 

The core of AHAG software is its ability to generate printed output or send 
output to a file.  All data, including the Work Sheet, Field Data, Calculations, 
and a blank data collection sheet, can be generated.  To begin the printing 
procedure, select the Print menu option within the File menu.  This will open 
up a new menu with the four options for printing:  Work Sheet, Field Data, 
Calculations, and Field Sheet.  The first three reports simply print the data 
that can be viewed while in the software.  However, the Field Sheet is a blank 
data collection sheet that is based upon the Field Data defined in the study. 
This report is essentially the Field Data report without the data values printed. 
This output can then be used in the field to collect data for input into the 
computer at a later time. 

From this next menu, select the report to be generated.  When selected, the 
computer will prompt for the destination of the report, either the printer or a 
file.  If the printer is selected, the output will go directly to the printer.  If a 
file is selected, the computer will prompt for the name of the file in which to 
save the information.  This file will be located in the Reports directory speci- 
fied in the System Defaults (See Chapter 6 for more information).  The 
AHAG software does not require the user to specify any particular extension 
for these report filenames, nor does it append a default extension to the file- 
name.  This is left up to the user's discretion. 
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Exiting AHAG 

To exit the AHAG program and return to the DOS session, you must select 
the Exit menu choice from the File menu.  When this is selected, the program 
will prompt with a message box asking for confirmation of this action.  Select 
the [OK] button or press < ENTER > to finish exiting the program; other- 
wise, select [CANCEL] or <ESC> to return to running the AHAG program. 
When exiting AHAG, the software will prompt the user with a message box 
asking to save the current working session in memory.  If [YES] is chosen, 
then the user will be presented with the familiar save dialog box where the 
filename may be changed or kept and the session can be saved. 
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6    AHAG Edit Menu 

The AHAG Edit menu provides access into three main areas of data input: 
Study structure definition, Histogram and Graph development, and Field Data 
input. The Edit menu provides individual access into each of these three areas 
of an AHAG study. The first is the Definitions, which is the study structure 
definition. The second menu choice is the Work Sheet. It is in the work 
sheet where the functional relationships between Habitat Variables, Species, 
and Life Stages are created. Finally, the last menu choice gives access to the 
variables or Field Data defined in the definition of the study. 

Editing Definitions 

The first step in creating an AHAG study is to define the structure of the 
study file in terms of Habitat Variables, Species, and Life Stages. Remember 
to first create a new study by selecting the New menu choice in the File menu 
and typing in a study filename.  To begin this process, select the Definitions 
menu choice from within the Edit menu.  Once this choice is made, the pro- 
gram will present a new screen titled Definitions (See Figure 4).  It is from 
this editor that the changes to the study structure are made. 

There are three major areas that can be edited at this point: Habitat Vari- 
ables, Species, and Life Stages. To switch between the two windows, use the 
< TAB > key or press the primary mouse key on the window to edit in. The 
life stages are accessed by using the right arrow key when a particular species 
is currently highlighted. 

To increase the number of items in the screen, press the < INSERT > key; 
to remove an item, press the < DELETE > key with the highlighted cursor on 
the desired selection to delete. For example, to increase the number of habitat 
variables, move the cursor to the desired position to insert; then press the 
< INSERT > key, and a place will be created for a new Habitat Variable. 
Refer to Chapter 4 and the section on Editing Text and Data for information 
on changing names of items in this screen. 
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File Edit 

File: DEFLT1.DAT    Status: 
Fl Help F2 Save 

<HOME> <END> <PGUP> <PGDN> <ESC> 

Figure 4.     Example of Definitions screen 

Here is a list of the numbers of items that can be input in the Definitions: 

• 30 Habitat Variables. 

• 3 Species. 

• 5 Life Stages per species. 

22 

Editing Work Sheet 

Once the structure of the study has been defined, the mathematical struc- 
ture of model calculations is determined by selecting the Work Sheet menu 
choice from within the Edit menu. After this choice is made, the program 
will present a new screen that resembles a spreadsheet. This screen contains 
the structure of the study as defined in the Definitions section of the program. 
See Figure 5 for an example of this screen. 

Species and Life Stage are listed across the top of the work sheet, and 
Habitat Variables are listed down the left-hand side.  The rows and columns 
of data located within this matrix are the individual calculation cells used to 
compare against the Field Data for generating the calculations. The cells can 
be either a Histogram or a Graph. The type of cell is noted by using GRAPH 
to identify a Graph type and HIST to identify a Histogram type.  Each of 
these cells must be individually edited. To edit one of these cells, position the 
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File Edit Calcs Options  Help 

SPECIES & LIFESTAGE White Bass Emerald Shiner 

HABITAT VARIABLE Spawnin Rearing Juvenil Spawnin Rearing Juvenil 

Average Water Temperature HIST   HIST HIST HIST   HIST HIST 
Average Turbidity, NTU HIST   HIST HIST HIST   HIST HIST 
Minimum daily dissolved oxyge HIST   HIST HIST HIST   HIST HIST 
Percent of shoreline rip-rapp HIST   HIST HIST HIST    HIST HIST 
Dominant substrate type HIST   HIST HIST HIST   HIST HIST 
% surface with visible cover HIST   HIST HIST HIST   HIST HIST 
% surface with aquatic vegeta HIST   HIST HIST HIST   HIST HIST 
Water level fluctuation HIST   HIST HIST HIST   HIST HIST 
Variation in water depth, dep HIST   HIST HIST HIST   HIST HIST 
Variation in water depth, dep HIST   HIST HIST HIST   HIST HIST 
% area with water depth > lm HIST   HIST HIST HIST   HIST HIST 
% year/season contiguous back HIST   HIST HIST HIST   HIST HIST 
Average water velocity HIST   HIST HIST HIST   HIST HIST 
Average depth of thalweg HIST    HIST HIST HIST    HIST HIST 

File: NEW.DAT      Status: 
:Fl Help F2 Save F4 Cell Type 

<HOME> <END> <PGUP> <PGDN> <ESC> 

Figure 5.     Example of Work Sheet screen 

highlighted cursor on the desired items and press < ENTER > .  When this is 
done, the appropriate editor for the cell type will be invoked, either a Histo- 
gram or Graph editor. 

While editing the Work Sheet, it is possible to selectively omit a Habitat 
Variable from the final calculations for an individual Species and Life Stage. 
This is accomplished by moving the highlighted cursor to the desired Species 
and Life Stage and then press the < SPACEBAR > .  This will toggle the 
current status of that particular cell.  An asterisk (*) will appear just to the left 
of the cell type designation (either *HIST or *GRAPH) if the cell is to be 
omitted from the calculations.  Otherwise, no asterisk will appear if the cell is 
to be used in the calculations. 

Each cell type can be transformed to the other type. Press the < F4 > 
function key to open up a pop-up menu containing the choices for cell type, 
either Histogram or Graph.  Select the appropriate cell type and press 
< ENTER> .  The cell will now reflect the change within the matrix. 

Histogram Editor 

As its name implies, the histogram editor is used only to edit the data 
contained within a histogram. When this editor is started, a screen titled 
Histogram Editor is displayed containing the associated Habitat Variable, 

Chapter 6   AHAG Edit Menu 23 



Species, and Life Stage for the matrix component.  Figure 6 shows an exam- 
ple of this screen. 

Figure 6.     Example of Histogram Editor screen 

From within this editor, all of the data associated with the individual histo- 
gram can be edited.  There are five different sections to each row in the histo- 
gram.  The first three define the shape of the histogram.  The Start column 
identifies the first value in the individual histogram bin.  The End column 
identifies the last value for the individual histogram bin. The Operator defines 
the behavior to use when the model is computed during the calculations.  The 
following demonstrates the three operators that can be used. 

Example 1 
Start 
0.00 

Operator 
< 

End 
0.00 

Value 
0.10 

Weight 
1.00 

This row creates a bin with no width, but is used to describe a lower 
boundary condition. In the case that the field data value is less than 0.00, 
the resultant calculation will end up being 0.10. 

Example 2      10.00 10.00 0.90 1.00 

This row also creates a bin with no width, but is used to describe an 
upper boundary condition. In the case that the field data value is greater 
than 10.00, the resultant calculation will end up being 0.90. 

Example 3        1.00 3.00 0.20 1.00 
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This row creates a bin that represents a range encompassing 1.00 up to 
but not including 3.00. When the field data falls into this range, the 
resultant calculation will end up being 0.20. 

Example 4       1.00 - 1.00       0.50 1.00 
2.00 - 2.00 1.00 

This example represents when numeric results are not derived, but 
descriptive values such as substrate type are used. For this example then 

1.00 = silt with a value of 0.5 
2.00 = gravel with a value of 1.0 

The Value column is the HSI value used in calculations. The final column 
in the histogram editor is the Weight value used to increase or decrease the 
relative importance of an individual calculation. This weight is set to a 
default of 1.00 so that no change in the overall calculation is made.  A higher 
weighting value indicates increased importance of the variable in the overall 
calculations; the weight value should decrease to reflect a lower importance. 
Note that there is an upper limit of 20 rows of histogram data for each indi- 
vidual histogram. 

There is a limit value associated with each histogram cell in the matrix that 
is accessed by pressing the <TAB> key while editing rows of the histogram. 
By default, the limit will show a value of "NONE" to signify no limit used in 
the calculations. If you have previously defined a limit for a histogram, it can 
be removed by pressing the < F5 > function key. For more information on 
limiting values, please refer to Chapter 1. 

Graph Editor 

As its name implies, the graph editor is used only to edit the data contained 
within a graph.  When this editor is started, a screen titled Graph Editor is 
displayed containing the associated Habitat Variable, Species, and Life Stage 
for the matrix component.  Figure 7 shows an example of this screen. 

From within this editor, all data associated with the individual graph can 
be edited. There are two sections to each row in the graph. The first column 
is the X position on the graph, and the second column is the Y position on the 
graph.  Note that AHAG software linearly interpolates between points when 
generating calculations. Also, there is an upper limit of 20 points for each 
individual graph. 

To see a computer graphics representation of the graph, press the <F10> 
function key.  To exit viewing the graph, press the <ESC> key; the graph 
editing screen will reappear, and data points can continue to be added or 
edited. 
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Figure 7.     Example of Graph Editor screen 

There is a limit value associated with each graph cell in the matrix that is 
accessed by pressing the < TAB > key while editing rows of the graph.  By 
default, the limit will show a value of "NONE" to signify no limit defined for 
use in the calculations.  If you have defined a limit for a graph, it can be 
removed by pressing the < F5 > function key. 

Editing Field Data 

After the model has been completely defined in terms of both physical and 
mathematical structure, the model is ready to produce some outputs. How- 
ever, the data collected in the field and projected for future events must be 
entered before results of the calculations can be seen.  The process is started 
by selecting the Field Data menu choice from within the Edit menu.  Figure 8 
shows an example of how this screen looks. 

There are two parts to editing field data. The first is to fill in the header 
data associated with the AHAG study. The second is to fill in the individual 
values for Target Years and Habitat Variables. By default, you are placed 
into editing the header information when this screen is first invoked. The 
< TAB > key can be pressed to toggle between editing header information 
and individual values. 

AHAG software allows the user to load and save individual Field Data 
sheets into their own files.  This can be accomplished only while in the Field 
Data editor.  While the editor is in use, the function keys <F4> and <F5> 
are used to load and save these individual field data sheets, respectively. 
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Pile: NEW.DAT     Status: 
Fl Help F2 Save 

Figure 8.     Example of Field Data Editor screen 

When these functions are used, the loading and saving dialog box will be the 
same as that shown during the loading and saving of the entire AHAG study 
file. 

Note that the current field data sheet will be saved when an AHAG study 
file is saved.  Also, when saving AHAG study files, use the extension .DAT; 
when saving individual field data sheets, use the extension .FDS to differenti- 
ate between the two types of files. 

Study Header 

The study header consists of six main entries in addition to the number of 
target years identified in the # Time Periods entry.  These fields include: 
Sample Site, Date, Season, Notes, Habitat Area, and # Time Periods.  This 
header is printed out at the top of every report generated by AHAG to identify 
the study from which data were taken. The Sample Site is the name of the 
location being studied.  The Date is generally the date that the model was 
created or field data were collected. The Season is the time of year that the 
model represents (e.g., spring, summer, fall, and winter).  The Notes are a 
single line of data to help identify the study model.  The Habitat Area is the 
area under consideration (i.e., project area) for this model.  Finally, the # 
Time Periods represents the number of Target Years to include in the study 
(up to a maximum of 5 are allowed). As the # Time Periods field is changed, 
the AHAG software will automatically update the display to reflect this 
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change.  Target Years can be changed by moving the cursor (using right 
arrow key) to the individual years and making the appropriate change. 

Field Data Values 

The field data values are the values of a habitat variable determined from 
field measurements or predicted for future conditions. The entry form is 
similar to a spreadsheet similar to the one previously described for the Work 
Sheet. There is a cell for each Habitat Variable and its associated Target 
Year. To edit these cell values, use the arrow keys to move the cursor and 
fill in each field to reflect the measured or predicted data. When completed, 
press <ESC> to return to the main menu and proceed with viewing the 
calculations (as described in the next chapter). 
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7    AHAG Calcs Menu 

AHAG software provides quick and easy access to a variety of calcula- 
tions. HSI values can be calculated from the following choices: 

• Arithmetic mean of all variable scores (compensatory relationships). 
• Arithmetic mean of selected variables that are considered limiting. 
• Taking the single lowest HSI score (limiting factor). 

Habitat Units can be calculated for one point in time or annualized for the 
life of the project, referred to as Average Annual Habitat Units (AAHU) 
(USFWS 1980). 

Calculations are displayed when the Calcs menu choice is made from the 
main menu bar.  Each species and life stage is displayed on a single screen at 
one time.  Intermediate and summary calculations are made according to user 
requirements.  This chapter explains specific calculations made by AHAG, 
how they are generated, how to view the results, and how they can be saved 
to a file. 

Viewing Calculations 

Results of the calculations are displayed when you choose the Calcs menu 
option.  Each screen of information represents a single Species and Life Stage 
of the study definition.  To switch species and life stages, use the <TAB> 
key to move forward in the list, and use the key combination of < SHIFT- 
TAB > to move backwards in the list.  As each new Species and Life Stage is 
switched, the screen will be updated to reflect the respective calculations. 
Figure 8 shows an example of the calculations screen. 

Saving Calculations 

Calculations can be saved by two different methods.  The first was 
described in the printing section of this manual (See Chapter 5).  The second 
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Figure 9.     Example of Calculations screen 

method is to press the <F4> function key while viewing the calculations. 
When this is done, the program will prompt for a filename to save the results 
under.  This file will be stored in the Reports directory as defined in the 
System Defaults (See Chapter 6 for more information).  This file will be 
saved as an ASCII test file that can be loaded into a word processor for fur- 
ther editing.  Note that the software does not require any particular filename 
extension, so the user can choose any filename desired. 

Omitting Variables 

The AHAG software can selectively omit calculations for certain variables 
of individual species and life stages.  This is accomplished in the Work Sheet 
editing section of the program.  While in this editor, move to an individual 
cell that represents the habitat variable to be omitted for a species and life 
stage and press the <SPACEBAR>.  When the < SPACEBAR > is pressed, 
an asterisk (*) will appear to the left of the cell type name.  The asterisk 
indicates that this habitat variable is excluded from the computations for that 
particular species and life stage. If the < SPACEBAR > is pressed again, the 
asterisk will disappear and the habitat variable will once again be included in 
the computations. 

While viewing or printing the calculations, note that the AHAG software 
will place a series of four asterisks (****) in the place of a value if that partic- 
ular species and life stage was omitted from calculations. 
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8    AHAG Help Menu 

The AHAG software provides access to the on-line help system by two 
methods:  Context Sensitive and the Help Menu. Both of these on-line help 
aids access the same information but provide different entry points. The Con- 
text Sensitive help is available at any time throughout the system by pressing 
the <F1 > function key. The Help Menu is only available by selecting the 
help topics and using the menu choices in the Help Menu. 

Context Sensitive 

The Context Sensitive Help is available at any time throughout the AHAG 
software by pressing the <F1 > function key. When this key is pressed, the 
lower half of the screen opens up as a help window. In the help window, the 
AHAG software will provide on-line help for the section of the program ' 
currently being used. To exit help screens, press the <ESC> key and the 
program will return to the current program section. 

Help Menu 

Help index 

This menu choice provides an extended list of the various topics of on-line 
help that are available while using the AHAG software. From the Help-Index 
menu choice, the user can select the specific topic requiring further help. 

Help about 

The Help-About menu choice is a small window that pops up in the center 
of the screen that tells who wrote the AHAG software and various other cred- 
its for the AHAG implementation. 

Chapter 8   AHAG Help Menu 31 



9    AHAG Default Matrix 

AHAG has a default matrix of HSI values for eight species of fish that are 
common in the Upper Mississippi River System.  This matrix is not intended 
to serve as the final model for any particular study. However, they can be 
used as a starting point and appropriately modified for each study. This chap- 
ter describes the development and rationale of the default matrix. 

Geographic Area 

The default matrix of AHAG was designed for use in the Upper Missis- 
sippi River System.  The UMRS extends 926 miles1 from Hastings, MN, 
southward to Cauthersville, MO. Major tributaries include the Missouri and 
Illinois rivers.  To maintain a minimum 9-ft navigation channel, 29 dams were 
constructed from St. Louis, MO, to Minneapolis, MN (Rasmussen 1979). 
Most navigation pools are characterized by moderate flow, narrow in the 
upstream reaches, stable water levels with extensive backwaters in the middle 
reach, and deep, fluctuating water levels with few backwater areas in the 
lower reach (Eckblad 1986).  Dominant substrate in the Mississippi River and 
navigable tributaries is sand or clay, and most instream structure consists of 
wing dams, revetted banks, and fallen trees. Emergent and submersed aquatic 
vegetation are often found in backwater areas off the main channel. The 
unregulated reach of the Mississippi River below St. Louis is more turbid than 
the upper reaches, with swift currents, little instream cover, and few back- 
water areas. 

Evaluation Species 

Description of Upper Mississippi River ichthyofauna 

Over 140 species of fish have been collected in the UMRS since record 
keeping began in the late 19th century (Van Vooren 1983). Many of these 

1    A table of factors for converting non-SI units of measurement to SI units is presented on 
page viii. 
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species are rare to uncommon because they occur in smaller tributaries of the 
UMRS, are at the periphery of their range, or have experienced population 
declines because of water resource development.  Excluding these species, a 
total of 82 species (Table 1) are common or abundant in the Upper Mississippi 
River and lower reaches of large tributaries (Ohio River, Missouri River, and 
Illinois River). 

These 82 species are dominated taxonomically by minnows (21 species), 
suckers (12 species), sunfish (10 species), catfishes (8 species), and darters 
(7 species), which is typical of large alluvial rivers in the Mississippi River 
Valley (Hocutt and Wiley 1986). Most species maintain reproductive popula- 
tions in the main stem rivers and associated backwaters, although strays from 
upland tributaries (e.g., certain minnows and darters), recently introduced 
species (e.g., hybrid striped bass), and diadromous species (e.g., freshwater 
eel) also occur. 

Selection of evaluation species 

A guild is a group of species that exploit the same environmental resources 
(e.g., habitats) in similar ways (Root 1967). Therefore, members of a guild 
should be affected similarly by the alteration of those resources (Roberts and 
O'Neil 1985).  A guild matrix was constructed according to habitat preference 
and reproductive strategy of the species. Habitat and reproduction were con- 
sidered to be the most appropriate factors for guild development since habitat 
rehabilitation projects directly alter physical habitat conditions and the objec- 
tive of most projects is to provide spawning, rearing, and overwintering areas 
for fishes in the UMRS.  The 82 species listed in Table 1 were then segre- 
gated within the guild matrix based on a review of available life history data. 

There are numerous habitat classifications of the UMRS, but most follow 
that of Rassmussen (1979), which includes main channel, main channel bor- 
der, tailwaters, side channels, river lakes and ponds, and sloughs. However, 
the fish communities are similar among many of the these habitats. The guild 
attempts to avoid this repetition by considering two primary habitat types: 
lotic and lentic areas.  Lotic habitats include swift-water areas such as main 
channel, main channel border, tailwaters, and open side channels.  Lentic 
habitats include any slack-water areas such as sloughs, river lakes, and ponds. 
In addition, certain species that were considered ubiquitous and can tolerate a 
wide range of habitat conditions were assigned to a "generalist" category. 
Water velocity is assumed to be a major habitat axis along which fish species 
segregate in environments of large river systems (Leonard and Orth 1988; 
Baker, Killgore, and Kasul 1991). 

Habitat classification was further based on the premise that habitat use 
varies with size of adult species:  small species (< 100-mm total length) 
and large species (> 100-mm total length).  These criteria resulted in the 
formation of five categories (Table 2): lotic-large fishes (Group 1), 
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Table 1 
Fishes of the Upper Mississippi River and Their Respective Repro- 
duction and Habitat Guild for Juveniles and Adults 

Family and Species 
Reproduction 
Guild 

Habitat 
Guild 

Petromyzontidae 

Chestnut lamprey {Ichthyomyzon castaneus) 5 1 

Silver lamprey (A unicuspis) 5 1 

Acipenseridae 

Lake sturgeon (Acipenser fulvescens) 2 1 

Pallid sturgeon (Scaphirhynchus albus) 2 1 

Shovelnose sturgeon (S. platorynchus) 2 1 

Polyodontidae 

Paddlefish [Polyodon spathula) 2 3 

Lepisosteidae 

Spotted gar {Lepisosteus oculatus) 3 5 

Longnose gar (/.. osseus) 3 3 

Shortnose gar [L platostomus) 3 3 

Amiidae 

Bowfin (Amia calva) 10 5 

Anguillidae 

American eel (Anguilla rostrata) 1 3 

Clupeidae 

Skipjack herring (Alosa chrysochloris) 1 1 

Gizzard shad [Dorosoma cepedianum) 1 5 

Hiodontidae 

Goldeye (Hiodon alosoides) 1 1 

Mooneye (H. tergisus) 1 1 

Esocidae 

Northern pike (Esox lucius) 3 3 

Cyprinidae 

Mississippi silvery minnow {Hybognathus nuchalis) 4 5 

Common carp [Cyprinus carpio) 3 5 

Speckled chub {Macrhybopsis aestivalis) 1 2 

Silver chub {M. storeriana) 1 2 

Golden shiner {Notemigonus crysocleucas) 4 5 

Emerald shiner (Notropis atherinoides) 1 2 

(Sheet 1 of 3) 

Note:  The definitions for each habitat and reproduction guild number are found in Tables 2 
and 3, respectively. 
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Table 1 (Continued) 

Family and Species 
Reproduction 
Guild 

Habitat 
Guild 

Cyprinidae (Continued) 

River shiner (A/, blennius) 1 2 

Ghost shiner (A/, buchanani) 4 4 

Bigmouth shiner {N. dorsalis) 2 2 

Pugnose minnow (N. emiliae) 4 4 

Spottail shiner {N. hudsonius) 4 4 

Silverband shiner (A/, shumardi) 4 2 

Sand shiner {N. stramineus) 4 2 

Mimic shiner (N. volucellus) 1 2 

Red shiner (Cyprinella lutrensis) 4 5 

Spotfin shiner (C. spilopterus) 6 2 

Blacktail shiner (C. venustus) 6 2 

Redfin shiner {Lythrurus umbratilis) 11 4 

Bullhead minnow (Pimephales vigilax) 12 5 

Bluntnose minnow (P. notatus) 12 5 

Fathead minnow {P. promelas) 12 5 

Catostomidae 

River carpsucker (Carpiodes carpio) 4' 3 

Quillback [C. cyprinus) 2 3 

Highfin carpsucker (C. ve/ifer) 2 1 

White sucker (Catostomus commersoni) 2 1 

Blue sucker [Cycleptus elongatus) 2 1 

Smallmouth buffalo (Ictiobus bubalus) 3 3 

Bigmouth buffalo (A cyprinellus) 3 3 

Black buffalo (/. niger) 3 3 

Spotted sucker [Minytrema melanops) 2 3 

Silver redhorse [Moxostoma anisurum) 2 1 

Golden redhorse (M. erythrurum) 2 1 

Shorthead redhorse {M. macrolepidotum) 2 1 

Ictaluridae 

Blue catfish Ucta/urus furcatus) 12 3 

Channel catfish (/. punctatus) 12 3 

Black bullhead {Ameiurus me/as) 12 5 

Yellow bullhead {A. natalis) 12 5 

Brown bullhead (A. nebulosus) 12 3 

Stonecat {Noturus flavus) 12 2 

Tadpole madtom (A/, gyrinus) 12 4 

Flathead catfish (Pylodictis olivaris) 12 3 

(Sheet 2 of 3) 
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Table 1 (Concluded) 

Family and Species 
Reproduction 
Guild 

Habitat 
Guild 

Cyprinodontidae 

Blackstripe topminnow {Fundulus notatus) 3 5 

Poeciliidae 

Mosquitofish [Gambusia affinis) 13 5 

Gadidae 

Burbot {Lota lota) 2 1 

Atherinidae 

Brook silverside (Labidesthes sicculus) 4 4 

Percopsidae 

Trout-perch [Percopsis omiscomaycus) 4 3 

Percichthyidae 

White bass (Morone crysops) 2 1 

Yellow bass {M. m/'ssissippiensis) 2 1 

Centrarchidae 

Rock bass (Ambloplites rupestris) 9 4 

Green sunfish {Lepomis cyanellus) 5 

Warmouth (L gulosus) 4 

Orangespotted sunfish (L. humilis) 5 

Bluegill (L. macrochirus) 4 

Longear sunfish [L. megalotis) 4 

Smallmouth bass [Micropterus dolomieu) 9 1 

Largemouth bass {M. salmoides) 4 

White crappie [Pomoxis annularis) 4 

Black crappie (P. nigromaculatus) 4 

Percidae 

Western sand darter [Ammocrypta clara) 4 2 

Johnny darter {Etheostoma nigrum) 12 4 

Logperch {Percina caprodes) 4 4 

River darter {P. shumardi) 4 2 

Yellow perch {Perca flavescens) 3 3 

Sauger (Stizostedion canadense) 2 1 

Walleye (S. vitreurn) 2 3 

Sciaenidae 

Freshwater drum [Aplodinotus grunniens) 1 1 

(Sheet 3 of 3) 

36 
Chapter 9   AHAG Default Matrix 



Table 2 
Description of Habitat Groups for Fishes of the Upper Mississippi 
River 

Group 1 

Lotic-large fishes These fish are large (>300 mm), pelagic- 
oriented species that prefer rather clear, 
fast-flowing water over a sand or gravel 
substrate.  Most species are migratory, 
travel in schools, and often constitute an 
important commercial fishery.  Spawning 
occurs over sand or gravel shoals in the 
spring. The fry of this group are usually 
pelagic and move into shallower water as 
they grow, feeding on plankton and small 
invertebrates. The adults feed on large 
invertebrates or fishes. 

Group 2 

Lotic-small fishes This group is mostly comprised of small 
(< 100 mm) minnows and darters.  Species 
in this group are important forage fishes, 
and their presence generally indicates good 
riverine habitat. They often travel in 
schools and occupy similar habitat as 
described for species in Group 1, but gener- 
ally occur in shallower water and do not 
migrate great distances.  Reproduction 
behavior is variable, but spawning usually 
occurs during the spring over sand or 
gravel in flowing water. Their diet consists 
of plankton and small invertebrates. 

Group 3 

Lentic-large fishes This group inhabits slack-water areas sea- 
sonally connected to the main stem river. 
They generally avoid strong current unless 
traveling between habitats.  Because of 
their large size and relative high abundance, 
many of these species are important com- 
mercial and recreational fish. They often 
associate with vegetation, woody debris, or 
other forms of cover in deeper parts of 
pools, occasionally entering flowing water 
to feed.  Some species are piscivorous as 
adults, while others, such as suckers and 
bullheads, feed on mollusks, insects, and 
plankton.  Spawning occurs during the 
spring and early summer in shallow, non- 
flowing water over vegetation, logs, or 
prepared nests.  One notable exception is 
the American eel, which spawns around the 
Sargasso Sea. 

(Continued) 
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Table 2 (Concluded) 

Group 4 

Lentic-small fishes This group of relatively small fish are com- 
mon in slack-water habitats seasonally 
connected to the main stem river.  They are 
typically found in shallow, clear to moder- 
ately turbid water with little current.  Most 
species associate with some form of sub- 
merged cover.  Spawning occurs in spring 
and early summer in shallow water. Sun- 
fish deposit eggs in prepared nests, while 
others spawn along a sandy or clay sub- 
strate without parental care. The young 
often school and become pelagic, but 
return to shallow areas with submerged 
timber or aquatic vegetation as they grow. 
The fry consume plankton and later small 
crustaceans and insects.  Fish are also 
eaten, particularly by the adult sunfish. 

Group 5 

Generalists These fishes occur in a variety of habitats 
and are widespread throughout their range. 
They can live in slack-water areas that are 
noncontiguous with the main stem river. 
Most species in this group tolerate a wide 
range of environmental conditions, includ- 
ing high turbidity, low dissolved oxygen, 
and high water temperatures. They are 
often the first inhabitants of disturbed habi- 
tats and can survive in isolated pools, but 
generally prefer shallow, sluggish waters 
with vegetation.  Most have an extended 
spawning season throughout the spring and 
summer over a variety of substrates.  Sun- 
fish and bullheads prepare nests and guard 
the eggs, while others broadcast their eggs 
with no parental care.  Mosquitofish eggs 
are fertilized internally, and females give 
birth to living young. The young of this 
group are usually confined to shallow, 
protected areas.  The diet consists of plank- 
ton and invertebrates.  Bullheads and sun- 
fish will also consume small fishes. 

lotic-small fishes (Group 2), lentic-contiguous-large fishes (Group 3), lentic- 
contiguous-small fishes (Group 4), and generalists (Group 5). Although there 
are exceptions, most members of a habitat category share important morpho- 
logical similarities (e.g., fusiform shape for swift-water fishes and laterally 
compressed for slack-water fishes) and exhibit the same ontogenetic shifts in 
preferred habitat (e.g., shallow vegetated areas to open water). 
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Fishes were also assigned to 1 of 13 reproductive strategies (Table 3) 
according to modification of the evolutionary classification developed by 
Balon (1984). 

Table 3 
Reproductive Modes of Fishes of the Upper Mississippi River 

Number 

Nonguarders 

Open substratum spawners Pelagophils (float) 1 

Lithophils (rock and gravel) 2 

Phytophils (plants) 3 

Litho-Psammophils (sand/gravel) 4 

Brood hiders Lithophils (rocks and gravel) 5 

Speleophils (crevice-spawners) 6 

Guarders 

Substratum choosers Lithophils 7 

Phytophils 8 

Nest spawners Lithophils 9 

Phytophils 10 

Litho-Psammophils 11 

Speleophils 12 

Bearers 

Internal Bearers Viviparous 13 

Note:  Based on Balon (1984). 

Excluding mosquito fish (Gambusia affinis) that are viviparous (see 
Table 2), guild cells were developed by combining reproduction and habitat 
classifications resulting in 22 cells (Table 4). 

Evaluation species were selected from the guilds to represent commercial, 
sport, and forage fishes whose life history and ecology are relatively well 
known, thus allowing documented models to be developed.  Selection was by 
consensus of biologists with the USFWS, U.S. Army Engineer District, Rock 
Island, Iowa Department of Natural Resources, Wisconsin Department of 
Natural Resources, and the U.S. Army Engineer Waterways Experiment 
Station (WES).  The evaluation species selected were white bass, emerald 
shiner, river darter, northern pike, smallmouth buffalo, walleye, largemouth 
bass, and bluegill.  Excluding the generalists group, these eight species repre- 
sent 77 percent of all fishes that are common to abundant in the UMRS. 
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1 Table 4 
Reproductive and Habitat Guild of Fish Species of the Upper Mississippi River 

| System 

Lotic-Large Lotic-Small Lentic-Large Lentic-Small 
1 Fishes Fishes Fishes Fishes Generalists 

|                                                                                    Pelagophils 

Skipjack herring Speckled chub American eel Gizzard shad 
Goldeye Silver chub 
Mooneye Emerald shiner1 

Freshwater drum River shiner 
Mimic shiner 

Phytophils 

Longnose gar Spotted gar 
Shortnose gar Common carp 
Northern pike1 Blackstripe topminnow 
Smallmouth buffalo1 Bowfin 
Bigmouth buffalo 
Black buffalo 
Yellow perch 

Lithophils ' 

Chestnut lamprey Paddlefish Rock bass 
Silver lamprey Spotted sucker 
Lake sturgeon Walleye1 

Pallid sturgeon 
Shovelnose sturgeon 
Highfin carpsucker 
White sucker 
Blue sucker 
Silver redhorse 
Golden redhorse 
Shorthead redhorse 
Burbot 
White bass1 

Yellow bass 
Smallmouth bass 
Sauger 

Litho-Psammophils 

Bigmouth shiner River carpsucker Ghost shiner Golden shiner 
Silverband shiner Quillback carpsucker Pugnose minnow Red shiner 
Sand shiner Trout-perch Spottail shiner MS silvery minnow 
Western sand darter White crappie Redfin shiner Green sunfish 
River darter1 Black crappie 

Largemouth bass1 
Brook silverside 
Warmouth 
Bluegill1 

Longear sunfish 
Logperch 

Orangespotted sunfish 

Speleophils 

Blue catfish Spotfin shiner Flathead catfish Tadpole madtom Bullhead minnow 
Blacktail shiner Channel catfish Johnny darter Bluntnose minnow 
Stonecat Brown bullhead Fathead minnow 

Black bullhead 
Yellow bullhead 

1  Evaluation species. 
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Other species can be chosen from the guilds if they are considered impor- 
tant in a particular project and information on their life history and habitat 
preferences is sufficiently documented.  AHAG can be easily modified to 
incorporate additional species that represent more of the guild cells, and thus 
the fish community, or exclude existing species if they do not occur in the 
study area. 

Life history and ecology of evaluation species 

Life history information is provided for each evaluation species as a basis 
for developing HSI scores. This information is not intended to be comprehen- 
sive, but rather a cursory description of habitat utilization by the evaluation 
species.  Users of AHAG are encouraged to consider other life history data 
for a particular species that is pertinent to the geographical area or engineering 
project and make any necessary modifications to the models.  Unless other- 
wise indicated, life history information was summarized from HSI models 
published in the Biological Report Series by the USFWS for the following 
species: white bass (Hamilton and Nelson 1984), northern pike (Inskip 1982), 
smallmouth buffalo (Edwards and Twomey 1982), walleye (McMahon, 
Terrell, and Nelson 1984), largemouth bass (Stuber, Gebhart, and Maughan 
1982a), and bluegill (Stuber, Gebhart, and Maughan 1982b). For those spe- 
cies without published HSI models (emerald shiner and river darter), descrip- 
tions of life history relied on information from Becker (1983), Pflieger (1975), 
Smith (1979), Trautman (1981), and primary literature. 

White bass. White bass are laterally compressed, silvery species common 
in large rivers and reservoirs.  Their weight rarely exceeds 3 lb, and their life 
span is seldom more than 4 years.  They inhabit open water in large rivers 
with moderate current.  White bass are tolerant of moderate turbidity and 
avoid areas with continuous high turbidity.  White bass form large schools and 
feed near the water surface in early morning and late evening (Pflieger 1975). 
Adults are usually piscivorous, while juveniles consume small crustaceans and 
insects.  White bass production is high where large populations of forage fish 
exist (Hamilton and Nelson 1984). 

White bass reach sexual maturity at 2 to 3 years; males usually mature 
1 year earlier than females.  Spawning runs occur early in the spring when 
water temperatures reach 12 to 16 °C.  White bass prefer to spawn in running 
water over gravel substrate, but will also spawn over rocks in lentic environ- 
ments.  Fertilized eggs sink and stick to gravel, rocks, or vegetation.  Adults 
return to deeper water immediately after spawning. White bass larvae drift 
with the currents and eventually move into backwaters or other protected 
habitats. The young avoid dense vegetation and shallow areas with dense 
vegetation; they prefer shallow water over sandy beaches (Becker 1983). 

Emerald shiner. Emerald shiners are common inhabitants of large lakes 
and rivers in the UMRS and are an important food for many species of fish. 
They are a slender, laterally compressed species with a maximum size of 

Chapter 9   AHAG Default Matrix 41 



42 

about 95 mm and have large eyes (Douglas 1974).  Emerald shiners are usu- 
ally found in open channels having low to moderate velocities and in a wide 
range of turbidities and bottom types.  There is no decided preference for 
structure such as logs and aquatic vegetation.  Emerald shiners are a schooling 
species that live in midwater during the day and often come to the surface at 
night to feed. They feed by sight on small invertebrates: crustaceans in lentic 
habitats (Ewers 1933; Fuchs 1967) and aquatic and terrestrial insects in lotic 
environments (Mendelson 1975; Whitaker 1977). 

Emerald shiners reach sexual maturity within 1 year and live no longer 
than 3 years (Fuchs 1967). Spawning begins late in the spring when water 
temperatures reach 22 °C and continues through July or August.  They spawn 
at night in large schools. Nonadhesive eggs are deposited over sand, gravel, 
or firm mud in depths of 2 to 6 m with slow to moderate velocities. The eggs 
sink to the bottom and hatch in 24 to 36 hr. The fry gather in schools in the 
open water of lakes and in the pools of rivers. 

River darter. River darters are the most common species of darter in the 
Mississippi River (Kuehne and Barbour 1983; Page 1983). They are demersal 
fish that inhabit moderate to fast current over rocks or gravel in medium to 
large rivers (Page 1983). River darters are extremely tolerant of high turbid- 
ity (Kuehne and Barbour 1983). Adults are usually found in waters greater 
than 1 m; juveniles can occur in water shallower than 0.5 m (Kuehne and 
Barbour 1983; Thomas 1970).  Adults and juveniles eat snails, midges, and 
caddisfly larvae (Thomas 1970). 

River darters reach sexual maturity at age 1 and can live at least 3 years 
(Thomas 1970).  They spawn in April or May, although earlier spawning is 
possible in the southern part of their range (Kuehne and Barbour 1983).  Like 
most darters, the males exhibit courting behavior prior to spawning.  They 
spawn over rubble, gravel, or sand in depths less than 1 m in areas of strong 
current (Kuehne and Barbour 1983). 

Northern pike. This species has a duck-bill shaped snout and a large 
mouth with many sharp teeth (Pflieger 1975).  Northern pike are an important 
sport fish in the UMRS.  Missouri is on the southern edge of the range for 
this northern species (Pflieger 1975).  Northern pike occur in backwaters and 
pools, avoid strong currents, and prefer areas with dense aquatic vegetation. 
They can tolerate low temperatures if dissolved oxygen is adequate; thus they 
are considered a cool-water species.  Northern pike travel extensively, often 
moving between backwaters in response to low dissolved oxygen, fluctuating 
water temperatures, or to avoid overcrowding (Becker 1983).  Northern pike 
become piscivorous early in life, but feed opportunistically on seasonally 
abundant food resources. 

Northern pike reach sexual maturity in 1 to 3 years.  They spawn in March 
or April as soon as the ice begins to break up in the spring (Becker 1983). 
Eggs are deposited over vegetation in shallow water.  Newly hatched larvae 
adhere to vegetation by using a sucker-type membrane on the top of the head 
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(Becker 1983).  Fry emigrate from spawning areas when they are 15 to 
20 mm long.  Growth of northern pike is rapid, and they can exceed 10 lb 
and usually live about 10 years. 

Smallmouth buffalo.  Smallmouth buffalo are important commercial fish 
in the Mississippi River drainage. They are suckers with a heavy head and a 
robust body (Douglas 1974). This riverine species occurs in deep, flowing 
water, but also frequents low-velocity areas such as sloughs, oxbow lakes, and 
other backwaters for resting, spawning, and rearing areas (Kallemeyn and 
Novotny 1977).  Buffalo can grow well in and tolerate turbid waters.  Small- 
mouth buffalo feed by searching the bottom for small crustaceans, snails, 
insect larvae, as well as algae and certain species of aquatic plants (McComish 
1967; Clay 1975). Young buffalo gather in shallow bays and feed primarily 
on Zooplankton and chironomid larvae. 

The age of sexual maturity is variable, but mature individuals weigh 
approximately 450 g and are age 2 to 6 (Walburg and Nelson 1966).  Spawn- 
ing coincides with rising water levels during the spring at temperatures from 
19 to 27 °C, peak spawning from 22 to 26 °C (Jester 1973).  Adhesive eggs 
are scattered over all bottom types in slack-water areas at depths of 1.2 to 
2.4 m, but spawning adults prefer substrates of recently inundated vegetation 
and other submersed objects (Jester 1973).  The eggs are left unattended by 
the adults, and incubation takes 4 to 12 days at 14 to 21 °C (Walburg and 
Nelson 1966). The fry prefer warm, shallow, backwaters (<20-cm/sec veloc- 
ity) and mud bottoms (Kallemeyn and Novotny 1977). 

Walleye. Walleyes are one of the most important game fish in North 
America.  They occur in loose aggregations in moderate to large lake and 
river systems.  They prefer areas with clear water, cool temperatures, shallow 
to moderate depths (< 15 m), and substrates of sand, gravel, rubble, and boul- 
ders.  Walleyes are sometimes found in slight currents except during the 
winter when they avoid turbulent areas. Adults are found in deeper waters 
during the day and move inshore at night to feed. The diet of juveniles and 
adults consists primarily of fish.  Walleye fry eat Zooplankton and aquatic 
insects. 

Male walleyes reach sexual maturity at approximately 5 years, while 
females mature at about 7 years.  Walleyes spawn at night during the spring 
shortly after ice breakup at temperatures ranging from 6 to 11 °C.  Adhesive 
eggs are scattered over gravel, boulders, and sometimes vegetation in shallow 
water.  There is no nest preparation or parental care. Hatching occurs in 
about 7 days at a temperature of 15 °C.  Fry move to slack water where 
Zooplankton is abundant for feeding. 

Largemouth bass.  Largemouth bass are important recreational fish in the 
UMRS.  They have slightly compressed bodies and large mouths with pointed 
teeth positioned in brushlike pads on both upper and lower jaws (Douglas 
1974).  Like most centrarchids, largemouth bass occur in slow-moving water 
(< 20 cm/sec) with soft bottoms and abundant cover (40 to 60 percent) in the 
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form of aquatic vegetation, logs, brush, or debris (Miller 1975).  Largemouth 
bass prefer clear water and are intolerant of high turbidities (> 100 mg/f 
suspended solids) (Muncy et al. 1979; Buck 1956).  They move into protected 
backwaters during the winter months.  Largemouth bass juveniles consume 
mostly insects and small fish, and adults feed primarily on fish and crayfish 
(Emig 1966; Carlander 1977).  Largemouth bass fry feed mainly on micro- 
crustaceans and small insects (Carlander 1977). 

Largemouth bass mature and spawn as early as age 1 near the southern 
limit of their range (Clugston 1964; Smitherman 1975).  Spawning begins in 
the spring when water temperatures reach 16.0 to 22 °C (Becker 1983; Miller 
and Kramer 1971).  The males construct nests usually in shallow (0.3 to 
0.9 m), nonflowing water on a wide variety of substrates; gravel is preferred, 
but any type of firm, silt-free bottom is used.  Silty, mucky bottoms are 
unsuitable (Robinson 1961).  Eggs hatch in about 3 to 4 days, and the fry rise 
from the nest and begin to feed 5 to 8 days after hatching in low-velocity 
areas associated with cover (Aggus and Elliot 1975). The fry remain in a 
school as long as 31 days and are guarded all or part of this time by the male. 

Bluegill. Bluegill are a deep and slap-sided sunfish with a small mouth 
(Pflieger 1975). They are widespread throughout the eastern United States 
and are abundant in the UMRS.  Bluegill are a popular panfish and stocked in 
many areas.  This species prefers backwaters of rivers where aquatic plants or 
other forms of structure are present and is intolerant of continuous high 
turbidity (Pflieger 1975).  They are gregarious, often moving in loose aggre- 
gations of as many 20 to 30 individuals (Pflieger 1975).  Bluegill are opportu- 
nistic feeders consuming Zooplankton, aquatic and terrestrial insects, and some 
plant materials. 

Bluegill mature at age 1 or 2 and live 1 to 4 years.  They are repeat spaw- 
ners from spring through summer in water temperature ranging from 17 to 
31 °C.  Nests are constructed in nonflowing, shallow water over various sub- 
strates; gravel or sand is preferred.  The male guards the nests until the eggs 
are hatched.  The fry usually avoid currents and remain in the backwater feed- 
ing on Zooplankton.  The growth of bluegills is rapid and they can exceed 
lib. 

Habitat Suitability Index Values 

The default matrix is comprised of five types of variables (Table 5):  phys- 
icochemical, habitat structure, morphometric, hydraulic, and interspersion 
between habitats.  Many of these variables have been identified as important 
in structuring fish communities in a variety of stream ecosystems (Barnickol 
and Starrett 1951; Becker 1983; Gorman and Karr 1978; Leonard and Orth 
1988; Ross 1986; Smith 1979).  Furthermore, they characterize physical 
changes associated with high sedimentation rates and altered water level 
regimes that have influenced habitat quality in the UMRS. 

Chapter 9   AHAG Default Matrix 



Table 5 
Description of Habitat Variables Used in AHAG Default Matrix 

Types of Variables Variable Names Comments 

Physiochemical Average water temperature 
Average turbidity 
Minimum daily dissolved 

oxygen 

These are often referred to as water quality vari- 
ables. Temporal and spatial variability in values 
should be considered when quantifying in the field. 

Habitat structure Percent of shoreline riprapped 
Dominant substrate type 
Percent of surface area with 

visible logs, timber, undercut 
banks, and/or brush 

Percent of surface area with 
aquatic vegetation 

Intermediate levels of structural complexity is 
assumed optimum for reproduction, foraging, and 
predator avoidance.  In swift-water areas, cover 
and substrate are used as velocity refuges and 
feeding sites.  In slack-water areas, cover is used 
as spawning sites and food production areas.  Sub- 
strate is important for feeding and spawning. 

Morphometric Variation in water depth 
Percent of area with water 

depth greater than 1 m 
Average depth of thalweg 

Variation in water depth provides heterogeneous 
habitats.  Shallow water can hamper movement 
while foraging or avoiding predators and may be 
associated with high temperature and low DO. 

Hydraulic Water level fluctuation 
Average water velocity 

Fishes require slack-water areas such as bank 
indentions for resting, feeding, and spawning.  High 
water velocities hamper fishes' ability to maintain 
position for an extended period of time resulting in 
emigration from the area and/or low recruitment 
because of a lack of spawning and rearing habitat. 
Water level fluctuation can disrupt spawning. 

Interspersion Percent of year/season back- 
waters are contiguous with 
the main stem river 

Distance to nearest backwater 
with average water depth 
greater than 1 m 

Distance to side channel with 
permanent water > 2 m and 
connection to main stem river 

Interhabitat spatial relationships are considered to 
be biologically meaningful to fish that require more 
than one habitat to complete all life stages. 

Most variables in the default matrix can be measured along transects placed 
at representative sites within the project area.  Variables that require averages 
or percentages can be determined from transect data. Onsite mapping or use 
of aerial photography can also be used to estimate some variables, including 
interspersion distances between habitats.  Detailed information on measuring 
each of these variables can be found in Hamilton and Bergersen (1984).  The 
AHAG default matrix includes one additional variable that summarizes over- 
wintering habitat:   "Percent of backwater area suitable as overwintering habi- 
tat from Nov-May...".  This is an example of using only one variable that 
summarizes multiple conditions necessary to provide suitable habitat during a 
defined time period. 

HSI scores were determined by species and life stage (spawning, larvae, 
and juvenile/adult) from literature reviews, including "Blue Book HSI Mod- 
els" published by the USFWS and consensus from fishery biologists in the 
UMRS for application on a broad geographical scale; biologists were 
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represented by the USFWS, U.S. Army Engineer District, Rock Island, Iowa 
Department of Natural Resources, Wisconsin Department of Natural 
Resources, and WES. 

For each evaluation species, the range of habitat values were divided into 
classes, and an SI score was assigned to each class by life stage.  Each class 
interval was rated as excellent (1), good (0.75), fair (0.5), poor (0.25), or 
unusable (0) habitat.  As stated in Chapter 1, there are no HSI values for 
some variables.  This indicates that the species or life stage does not require 
this particular habitat variable for survival and growth.  HSI values that do not 
reach 0 (unusable habitat) or 0.25 (poor habitat) indicate that this variable may 
enhance growth, but is not a necessary requirement for survival of the species 
or life stage. 

Format of AHAG 

The AHAG default matrix for the eight evaluation species is shown in 
Table 6. The format allows the user to conduct separate evaluations of the 
study area by life stage of the species and for winter, spring, summer, and fall 
conditions.  For example, overwintering habitat of juvenile and adults can be 
evaluated by selecting only those variables that may limit their survival or 
abundance during the winter. 

Once the evaluation species have been chosen, the basic approach to an 
evaluation is as follows: 

• Select habitat variables that are considered important to abundance and 
condition or well-being of the species/life stage. 

• Make appropriate measurements of the variables in the field or predict 
the values using consensus or physical models. 

• Determine individual HSI scores from the matrix and obtain a final 
HSI value that rates the habitat quality of the project site.  A final HSI 
score can be obtained using the arithmetic mean of all variable scores, 
the arithmetic mean of a subset of variable scores, or taking the single 
lowest HSI score. 

• Determine area (e.g., acres) of the project site and multiply by the 
final HSI value to obtain HUs. 

• Compare HUs for each project alternative. 

AHAG software can be used to make all calculations and develop summary 
tables of the results. 
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Aquatic Habitat Appraisal Guide Software 
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Please send a copy of the Aquatic Habitat Appraisal Guide Software to {please type or 
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Vicksburg,MS 39180-6199 

NOTE:     To operate the software, you must have a 386 class or greater IBM-compatible 
PC, 600 KB of free RAM, and hard disk. 
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